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Pharmacokinetic Case Study Gentamicin Simulation 

 
Gentamicin Kinetics: 

A Simulation Exercise in Flip-Flop Kinetics and Toxicity 
 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 
This case study will show you how to use heuristic simulations to understand 
interindividual differences in toxic response to gentamicin therapy and the impact of 
different dosing regimens on gentamicin toxicity. Overall it demonstrates the power of 
simulating the outcomes of different dosing regimens. You will learn: 
 

• How to use simulations to understand how differences in gentamicin account for 
toxicity differences between patients.  

• How to use simulations to analyze the impact of different drug dosing regimens 
on gentamicin toxicity. 

• How “flip-flop” kinetics result from slow gentamicin distribution to a peripheral 
compartment. 

• How to use the Duplicate feature of the SAAM II Compartmental application. 
• How to incorporate Michaelis-Menten kinetics in a transfer function. 

 
Data Required 
 

No data files are required for this case study. 
 
Introduction 
 
In this case study, a number of simulations will be developed that are based on an actual 
analysis of gentamicin kinetics in patients who either tolerated intravenous therapy with 
this antibiotic without toxicity or developed significant nephrotoxicity [1]. Gentamicin 
owes its selective antibacterial action to the fact that it is unable to enter most mammalian 
cells but penetrates the cell walls of sensitive gram negative bacteria. Although 
gentamicin distributes primarily within the extracellular fluid (ECF) space, Schentag and 
co-workers demonstrated that it also distributes to a tissue compartment that they 
identified in autopsy studies as the kidney [2]. The mechanism for gentamicin uptake by 
renal tubular cells is thought to be receptor-mediated endocytosis. Gentamicin is 
eliminated from the body by glomerular filtration at a rate that approximates creatinine 
clearance. However, the distribution process is slow enough relative to the rate of 
gentamicin elimination that it accounts for the second rather than the first phase of 
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gentamicin’s biphasic plasma level-vs.-time curve. This situation is referred to as “flip-
flop” kinetics.  
 
We will use simulations to compare gentamicin distribution in a non-toxic vs. a toxic 
patient after administration of 80 mg intravenous doses of this drug at 8-hour intervals, 
the standard administration regimen when these studies were done. Different dosing 
regimens also appear to have an impact on the incidence of gentamicin toxicity. Studies 
in dogs have shown that continuous intravenous infusion of gentamicin for several days 
results in much more nephrotoxicity than when the same total dose is divided into once-
daily injections [3]. Therefore, we will use simulations in a heuristic fashion to compare 
the distribution of gentamicin after continuous infusion and after the once daily 
administration schedule that is the current standard. 
 
1. Coburn, W. A., Schentag, J.J., Jusko, W.J., Gibaldi, M. “A model for the prospective 

identification of the prenephrotoxic state during gentamicin therapy.” J. 
Pharmacokinet. Biopharm. 1978, 6:179-86. 

 
2. Schentag, J. J., Jusko, W. J., Vance, J. W., Cumbo, T. J., Abrutyn, E., DeLattre, M., 

Gerbracht, L. M. “Gentamicin disposition and tissue accumulation on multiple 
dosing.” J. Pharmacokinet. Biopharm. 1977, 5:559-77. 

 
3. Reiner, N. E., Bloxham, D. D., Thompson, W. L. “Nephrotoxicity of gentamicin and 

tobramycin given once daily or continuously in dogs.” J. Antimicrob. Chemother. 
1978, 4 (Suppl A):85-101. 

 
Part 1.  Investigate Gentamicin flip-flop kinetics in a non-toxic patient 
 
The first step will be to create the 2-compartment system model for a patient who 
tolerated an 8-day course of intravenous gentamicin therapy without toxicity. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. In the SAAM II Toolbox, be sure the Model tools are 
available. 

 
2. Create the following system model on the Drawing Canvas: 
 

 
3. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 

unavailable and the Experiment tools are available. The Experiment Attributes 
dialog box will open. 
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a. Change “minutes” to “hours” in the Units box. 
 
b. Enter “250” in the End at box. The Experiment Attributes dialog box will 

appear as follows: 
 

 
 

c. Click Done. 
 

The Create Experiment dialog box will appear on the Drawing Canvas. Type 
“Gentamicin” in the New Name box. The Create Experiment dialog box will 
appear as follows: 

 

 
 

d. Click Create. Note the name “Gentamicin” appears under Experiment in the 
SAAM II Toolbox. 

 
4. Create two samples. 

 
a. In the SAAM II Toolbox, double-click Sample (this will lock the Sample 

tool so you can create multiple samples). 
 
b. Click Compartment q1, then click on the Drawing Canvas. The sample s1 

will appear. 
 
c. Click Compartment q2, then click on the Drawing Canvas. The sample s2 

will appear. 
 
d. In the SAAM II Toolbox, click Select to unlock the Sample tool. 
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e. Double-click s1 to open the Sample Attributes dialog box. 
 
f. Edit the sample equation “s1 = q1” to read “s1 = q1/V1”. The Sample 

Attributes dialog box will appear as follows: 

 
g. Click Done.  
 
h. Double-click s2 to open the Sample Attributes dialog box. 
 
i. Edit the sample equation “s2 = q2” to read “s2 = q2/V2”. 
 
j. Click Done. 

 
5. Create an input. 

 
At the time of this study, gentamicin was routinely administered as an 80 mg 
intravenous infusion every 8 hours. The first simulation will be the response to a 
single administration of an 80 mg intravenous dose.  
 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 
c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Select Infusion as the Input Type. 
 
e. Enter “80” in the Constant Rate box. 
 
f. Enter “0” in the Event Start box. 
 
g. Enter “1” in the Event Stop box. 
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h. Click Add. The Exogenous Input dialog box will appear as follows: 

 
i. Click Done. 

 
6. Enter the pharmacokinetic parameter equations. 

 
You will now enter the following equations: 
 

CLe = V1*k(0,1)*1000/60 
V2 = V1*k(2,1)/k(1,2) 
Vss = V1 + V2 

 
Multiplication by 1000/60 converts the units for clearance Cle from L/hr to 
mL/min. The equation defining V2 means V2 is no longer a primary parameter 
that must be entered separately before you can solve. 

 
a. In the Show menu, click Equations, or alternatively, on the SAAM II 

Toolbar, click Equation  . The Equations dialog box will open. 
 
b. In the Equations Defined Here pane, type the above equations. The 

Equations dialog box will appear as follows: 
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c. Close the Equations dialog box. 
 
7.  Enter the parameter values. 

 
a.  In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. If V1 
is not selected, double-click V1 to select it. 

 
b. Select Fixed. Enter “17.7” in the Value box, and click Save.  
 
c. Double-click k(0,1). Select Fixed. Enter “0.08” in the Value box, and click 

Save. 
 
d. Double-click k(1,2). Select Fixed. Enter “0.007” in the Value box, and click 

Save. 
 
e. Double-click k(2,1). Select Fixed. Enter “0.006” in the Value box, and click 

Save. The Parameters Dialog box will appear as follows: 
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f. Click Done. 

 
8. Solve your model and view the solution. 

 
a. In the Compute menu, click Settings. The Computational Settings dialog 

box will open. 
 
b. Enter “500” in the Min. Nr. of Calculation Intervals box. Click Done. 
 

 Minimum number of calculation intervals. The number of calculation intervals 
determines the resolution of your plots. Because this is a simulation study 
with no data, it is useful to set this number to its maximum of 500 in order to 
obtain better plots.  

 
c. In the View menu, select Model Labels, and click Values. 
 

 Model labels. When you select Values for your model labels, the current 
values of the parameters will appear associated with you model instead of the 
name k(i,j). 
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d. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
e. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. 
 
f. In the Plot and Table Variables dialog box, be sure the List All Variables is 

not selected so s1 and s2 will appear as your only choices. 
 
g. Click s1 and s2 to move these to the Current Selection pane. 
 
h. Click Done. The following plot will appear (if it does not appear in semilog 

mode, in the View menu click Semilog): 
 

 
 

It can be seen that there is the expected biphasic plasma level-vs.-time curve and 
that the terminal phase is quite prolonged. We will demonstrate that this terminal 
phase represents slow re-distribution of gentamicin from the kidney to the ECF. 
 
i. Close the Plot window. 
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9. Create a duplicate model to illustrate flip-flop kinetics. 
 

Flip-flop kinetics will now be illustrated by creating a second gentamicin model 
that is identical to the first model except for increased renal clearance of 
gentamicin. 

 
a. While pressing the CTRL key, click in this precise order Compartments q1 

and q2, and s2, s1 and ex1. 
 

 Model duplication. The precise order is necessary for the internal bookkeeping 
in SAAM II. If you follow this sequence, your model will appear as shown 
below. In general for duplication, you can simply select the model or portion 
of the model you want to duplicate, and proceed. When you do this, however, 
there may be occasions when you have to alter the model.  

 
 
b. In the Edit menu, click Duplicate. The Duplicate dialog box will open as 

follows: 
 

 
 
c. Select the Set New Transfer Coefficients equal to counterparts box. The 

Duplicate dialog box should appear as shown below: 
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d. Click Duplicate and click the Drawing Canvas at the left margin below the 

initial system model. The following models should appear on the Drawing 
Canvas (you may need to move the duplicated model): 

 
 

 
 
 

Notice in the figure that the top model has the parameter values while the 
lower model does not. This is because the lower model transfers are defined 
by equations. 

 Model duplication. The model duplication capability of the SAAM II 
Compartmental application is a convenient method by which several copies of 
a model can be created. In this case, the samples and inputs have been 
retained. However, the input specifications for ex2 and the sample equations 
for s3 and s4 need to be written; these are not duplicated as part of the 
duplicate command. The precise order given in the instruction above was 
required in order for s3 and s4 to be attached to q3 and q4. The effect of 
selecting the Set New Parameters equal to counterparts box is to predefine 
the rate constants of the second model equal to those of the first. For example, 

©University of Washington PK.GentSim - 10 Rev. 08/09/14 



Pharmacokinetic Case Study Gentamicin Simulation 

if you double-click on k(4,3), you will see the equation “k(4,3) = k(2,1)”. This 
is shown in the Transfer Attributes dialog box: 

 

 
 

 
 

e. Double-click s3 to open the Sample Attributes dialog box, and edit the 
sample equation “s3 = q3” to read “s3 = q3/V3”. 

 
f. Click Done. 
 
g. Double-click s4 to open the Sample Attributes dialog box, and edit the 

sample equation “s4 = q4” to read “s4 = q4/V4”. 
 
h. Click Done. 
 

 10. Create a duplicate input. 
 
a. Double-click ex2 to open the Exogenous Input dialog box. 
 
b. Select Infusion as the Input Type. 
 
c. Enter “80” in the Constant Rate box. 
 
d. Enter “0” in the Event Start box. 
 
e. Enter “1” in the Event Stop box. 
 
f. Click Add. The Exogenous Input dialog box will appear as follows: 
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g. Click Done. 
 

11. Modify the equations for the pharmacokinetic parameters. 
 

You will now enter the following equations: 
 

CLel = V3*k(0,3)*1000/60 
V4 = V3*k(4,3)/k(3,4) 
Vss_2 = V3 + V4 

 
As before, multiplication by 1000/60 converts the units for Clel from L/hr to 
mL/min. In addition, the equation for V4 means V4 is no longer a primary 
parameter that must be entered separately before you can solve. 

 
a. In the Show menu, click Equations, or alternatively, on the SAAM II 

Toolbar, click Equation  . The Equations dialog box will open. 
 
b. In the Equations Defined Here pane, type the above equations. The 

Equations dialog box will appear as follows: 
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Notice that in the Equations Defined Elsewhere pane, the equations making 
the rate constants of the duplicated model equal to their counterparts in the 
first model. 

 
c. Close the Equations dialog box. 
 

12. Enter the new parameter values. 
 

a.  In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. If V3 
is not selected, double-click V3 to select it (this is the only parameter that 
needs to be specified). 

 
b. Select Fixed. Enter “17.7” in the Value box, and click Save. The Parameters 

Dialog box will appear as follows: 
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c. Click Done. 

 
13. Save the study file. 
 

This study file will be used in Part 3 of this case study. Thus it must be saved. 
 
a. In the File menu, click Save As. 
 
b. Enter “Gentamicin” in the File name box. 
 
c. Be sure you place the file in the proper Save in box. 
 
d. Click Save. 
 

14. Double the loss from Compartment q3. 
 

a. Double-click k(0,3). The Loss Attributes dialog box will open. 
 
b. Edit the equation “k(0,3) = k(0,1)” to read “k(0,3) = 2*k(0,1)”. The Loss 

Attributes dialog box will appear as follows: 
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c. Click Done. 
 

15. Solve your models and compare the solutions. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. If the 
previous plot of s1 and s2 appears, in the Set menu, click Plot/Table 
Variables to open the Plot and Table Variables dialog box.) 

 
c. In the Plot and Table Variables dialog box, be sure the List All Variables is 

not selected so s1, s2, s3 and s4 will appear as your only choices. 
 
d. Press the CTRL key and click s1, s2, s3 and s4 to move these variables to the 

Current Selection pane. 
 
e. Click Done. The following plot will appear (if it does not appear in semilog 

mode, in the View menu click Semilog): 
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Note that doubling the renal clearance of gentamicin increases the slope of the 
initial phase of the plasma level-vs.-time curve but does not affect the slope of the 
second phase. This is called “flip-flop kinetics” because the elimination phase 
precedes the distribution phase. Note also that gentamicin accumulation by the 
kidney is also predicted to vary inversely with the level of renal function. This 
would be expected if gentamicin doses were not adjusted downwards for patients 
with impaired renal function (see reference 2 cited above). 
 
f. Close the Plot window. 
 

Part 2. Pharmacokinetic basis for individual susceptibility to gentamicin 
nephrotoxicity.  

In this part of the case study, we will compare renal accumulation of gentamicin in a 
patient who developed nephrotoxicity with that of our reference, non-toxic patient. 

1. Enter parameter values characteristic of the toxic patient for the comparison with 
the nontoxic patient. 
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a. Double-click k(0,3) to open the Loss Attributes dialog box. 
 

b. Edit the equation “k(0,3) = 2*k(0,1)” to “k(0,3) = 0.069”. The Loss 
Attributes dialog box will appear as follows: 

 

 
 

c. Click Done. 
 
d. Double-click k(4,3) to open the Transfer Attributes dialog box. 
 
e. Edit the equation “k(4,3) = k(2,1)” to read “k(4,3) = 0.117”. 
 
f. Click Done. 
 
g. Double-click k(3,4) to open the Transfer Attributes dialog box. 
 
h. Edit the equation “k(3,4) = k(1,2)” to read “k(3,4) = 0.014”. 
 
i. Click Done. 
 

 Equations for transfers and losses. The transfers k(4,3) and k(3,4), and the loss 
k(0,3), are specified by equations. SAAM II will recognize this, and they will 
not appear in the Parameters window. Should you wish to change the values 
of any of these parameters, you will have to open the appropriate Transfer 
Attribute dialog box and manually change the value.  

 
 

j. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
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k. Change the Value of V3 from “17.7” to “15.3”. The Parameters dialog box 
will appear as follows: 

 

 
 
l. Click Done. 
 

2. Solve your models and compare the solutions. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. (If the 
previous plot of s1, s2, s3 and s4 appears, you may skip the next steps and go 
immediately to the plot below.) 

 
c. In the Plot and Table Variables dialog box, be sure the List All Variables is 

not selected so s1, s2, s4 and s4 appear as your only choices. 
 
d. Press the CTRL key and click s1, s2, s3 and s4 to move these to the Current 

Selection pane. 
 
e. Click Done. The following plot will appear (if it does not appear in semilog 

mode, in the View menu click Semilog): 
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It is apparent that the toxic patient is maintaining much higher central 
compartment levels of gentamicin than the non-toxic patient, even though both 
received the same dose. The toxic patient also demonstrates slightly higher tissue 
concentrations of gentamicin. However, nephrotoxicity is presumably related to 
net kidney uptake of gentamicin. Proceed as follows to compare kidney uptake in 
the two patients: 
 
f In the Set menu click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
 
g. Select the List All Variables box. 
 
h. Click q2; this will replace the previous selections. Then press the CTRL key 

and click q4 to move these to the Current Selection box. 
 
i. Click Done. The following plot should appear: 
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It is apparent since q4 is larger than q2 that there is far greater accumulation 
of gentamicin in the patient with nephrotoxicity than in the non-toxic patient. 
Note that the coefficient for gentamicin transfer from the ECF to the kidney is 
almost 20 times greater in the toxic than in the non-toxic patient. 

 
j. Close the Plot window. 
 

Part 3. Impact of gentamicin dosing regimen on nephrotoxicity. 

In this part of the case study, a comparison of the impact of different gentamicin dosing 
regimens on the renal accumulation of this drug will be made. The reference, non-toxic 
patient for these simulations, saved in Gentamicin.stu, will be used as the study file. 

1. Open the SAAM II study file “Gentamicin.stu.” Be sure the maximum number 
of calculation intervals is set at 500. If it is not, set it equal to 500. 

2. Modify the inputs ex1 and ex2. 
 

A 7-day course of gentamicin therapy for both patients will be simulated. The 
reference patient will receive a 1-hour intravenous infusion of 240 mg every day; 
this is the dose-frequency regimen that was used in the study cited in reference 3 
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and that is used most frequently at this time. The comparison patient will receive 
a continuous infusion at a rate of 10 mg/hr.  
 
a. Double-click ex1 to open the Exogenous Input dialog box for the reference 

patient. 
 
b. Enter “240” in the Constant Rate box (replacing “80”). 
 
c. Enter “24” in the Repeat Every box. 
 
d. Enter “6” in the Nr. of Repeats box.  
 
e. Click Save. The Exogenous Input dialog box will appear as follows: 
 

 
 
f. Click Done. 
 
g. Double-click ex2 to open the Exogenous Input dialog box for the comparison 

patient. 
 
h. Enter “10” the Constant Rate box. 
 
i. Enter “168” in the Event Stop box. 
 
j. Click Save. The Exogenous Input dialog box will appear as follows: 
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k. Click Done. 
 

3. Solve your models and compare the solutions. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . If a previous plot opens, in the Set menu, click Plot/Table 
Variables to open the Plot and Table Variables.  

 
c. In the Plot and Table Variables dialog box, be sure the List All Variables is 

not selected so s1, s2, s3 and s4 will appear as your only choices. 
 
d. Press the CTRL key and click s1, s2, s3 and s4 to move these to the Current 

Selection pane. 
 
e. Click Done. The following plot will appear (if it does not appear in linear 

mode, in the View menu click Semilog): 
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It appears that apparent kidney concentrations of gentamicin are somewhat 
higher with intermittent than with continuous infusion therapy. However, 
toxicity in this case is most like the result of the total amount of gentamicin 
taken up by renal tubular cells. This can be evaluated as follows: 

 
f. In the Set menu click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
 
g. Select the List All Variables box. 
 
h. Click q2. Then press the CTRL key and click q4 to move these to the 

Current Selection pane. 
 
i. Click Done. The following plot should appear (the scale for the Y Axis 

maximum has been changed to “75”): 
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There is certainly no evidence that the continuous infusion of gentamicin 
results in less renal accumulation of this drug than when the same dose is 
given intermittently. Hence the pharmacokinetic model needs revision 
because it fails to account for this important experimental observation. 
 
A likely explanation for this shortcoming of the model is that receptor 
mediated endocytotic uptake of gentamicin by renal tubule cells is saturable at 
high gentamicin concentrations. This could explain why intermittent dosing 
results in less renal tubule cell gentamicin uptake and consequent 
nephrotoxicity. . 
 
To explore this possibility, we must move from a linear to a nonlinear model 
by writing the rate constants k(2,1) and k(4,3) to display Michaelis-Menten 
kinetics. 
 

j. Close the Plot window. 
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4. Write the transfer for renal uptake of gentamicin as a Michaelis-Menten process. 

 
a. Double-click k(2,1) to open the Transfer Attributes dialog box. 
 
b. Type the equation “k(2,1)=Vmax/(Km+s1)” in the Equation pane. The 

Transfer Attributes dialog box will appear as follows: 
 

 
 
c. Click Done. 
 
d. Double-click k(4,3) to open the Transfer Attributes dialog box. 
 
e. Type the equation “k(4,3)=Vmax/(Km+s3)” in the Equation pane.  
 
f. Click Done. 
 

5. Enter the values for the Michaelis-Menten parameters Vmax and Km. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
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b. Double-click Km to select it.  
 

(1) Select the Fixed option. 
 
(2) Enter “1” in the Value box. 
 
(3) Click Save. 
 

c. Double-click Vmax to select it.  
 

(1) Select the Fixed option. 
 
(2) Enter “0.5” in the Value box. 
 
(3) Click Save. The Parameters dialog box will appear as follows: 
 

 
 
d. Click Done. 
 

5. Solve your models and compare the solutions. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
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b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Since your last plot was of q2 and q4, this plot should appear 
(in linear mode). If it does not, open the Plot and Table Variables dialog 
box, and select q2 and q4. In the following plot the Y Axis maximum has 
been set to “800”. 

 

 
 

Although the parameter estimates are arbitrary, this plot is consistent with 
experimental observations in that renal accumulation of equal administered 
gentamicin doses is greater when the drug is given by continuous intravenous 
infusion than when it is administered intermittently. 
 
Examples of dose-regiment dependency in clinical medicine are not numerous 
and in most cases, including this one, their basis is poorly understood.  This 
exercise is of heuristic value because it demonstrates that the observed 
dependence of nephrotoxicity on gentamicin dose regimen would not occur 
were it not for the fact that the renal tubular uptake of this drug is mediated by 
a saturable process. 
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Since this exercise was created, Lui and Bendayan have in fact demonstrated 
that gentamicin uptake by cultured renal epithelial cells is saturable with a 
Vmax of 289 pmol/min·mg and a Km of 1.26 mM.  However, incorporation of 
these results into a more realistic model would require additional data, for 
example specification of actual gentamicin concentrations in renal tubular 
lumina.  These concentrations can be expected to be considerably higher than 
the plasma concentrations used in this simulation exercise. 
 
 
Liu, E. C.-C., Bendayan, R.”Gentamicin uptake by LLCPK1 cells: effect of 
intracellular and extracellular pH changes.” Can. J. Physiol. Pharmacol. 
1998,76:155-60. 
 
 

You may now Quit the SAAM II Compartmental application. You may save the study 
file for future reference if you wish. 
  
 
Essential Points to Remember 
 
• Simulations can provide important insight in understanding pharmacokinetic systems 

and the therapeutic implications of different pharmacokinetic results and drug dosage 
regimens.  The simulations in this case are particularly helpful in providing a 
pharmacokinetic rationale for clinical observations that gentamicin nephrotoxicity is 
dose-regimen dependent. 

 
• The model duplication feature in SAAM II is a powerful tool that can be used in 

conducting comparisons of different simulated results. 
 
• Flip-flop kinetics can reflect a slow drug distribution rate as well as slow absorption, 

e.g. from an extended release formulation. 
 
• Michaelis Menten kinetics can be incorporated in drug intercompartmental transfer 

processes as well as in modeling drug elimination.  
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